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Purpose of this Guide  

This guide outlines accessibility considerations and standards, which provided a robust basis 
for the development of accessible, inclusive, quality open learning materials during the 
Every1 project’s duration. 

Background to the Every1 project’s Learning Materials  

The Every1 project (https://every1.energy) delivered 87 English language learning materials 
on energy digitalisation in 16 different online and offline formats. Selected learning 
materials were translated into a range of different European languages. All project learning 
materials, and associated curated learning pathways, are available via the Every1 
Knowledge Hub (https://every1.energy/knowledge-hub).  

You can find out more about how the learning materials were developed in the combined 
D4.1/D4.2 report: https://every1.energy/pubreports 

Every1 learning materials are openly licensed, which means permission for sharing and 
reuse is already given. Every1 materials are licensed CC BY-SA 4.0. This Creative Commons 
license enables users to share, copy, make changes to and create new versions of materials, 
with appropriate attribution and under the same license terms.  

Developing openly licensed learning materials is core to the project’s sustainability strategy. 
To support effective reuse of Every1 learning materials, the project has developed a range 
of training materials, including this guide. You can find these resources in the Every1 OER 
Remix Toolkit.  

 

  

https://every1.energy/
https://every1.energy/knowledge-hub
https://every1.energy/pubreports
https://creativecommons.org/licenses/by-sa/4.0/deed.en
https://www.open.edu/openlearncreate/course/view.php?id=18230
https://www.open.edu/openlearncreate/course/view.php?id=18230
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General Accessibility Principles for Online and Offline 
learning materials 
 

The following sections outline guidance and principles for developing a range of different 
online and offline learning materials.  

 

Accessibility principles for Word documents (and similar) and 
Slideshows (PowerPoint and similar) 

 

If these principles are followed for Word documents that will become PDFs, there will be 
few additional checks required for the resulting PDFs. 

 

Use Heading Styles (Word and similar). 

● Found on the Home tab of the ribbon. Ensure that Headings are marked as the 
appropriate level of Headings, and that all body text is marked as ‘Normal’. Each 
default style can be modified to suit your needs (right-click the style and choose 
Modify). 

● Don’t skip levels. Nest sub-level headings beneath upper-level headings. This 
document itself has been set-up this way.  

 

Make images ‘Inline’ (Word and similar). 

● Word (and similar software) gives options for embedded images, media etc to be 
either ‘inline’ or ‘floating’ – choose ‘inline’ where possible.  

● Check with Word Accessibility Checker (Review tab of ribbon) – issues highlighted as 
‘Object not inline’. 

● Where ‘floating’ objects are unavoidable, ensure both the object and wrapped text 
around the object are part of the read order. 

 

Punctuate bullet points (Word and PowerPoint). 

● Every item in a list should have a comma, semi-colon or full stop after it. 
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● Note that the latest versions of Word no longer require this as they read lists in an 
appropriate manner regardless. 

 

Don’t convey information by only visual means (Word and PowerPoint). 

● It is fine to use colour to indicate something as long as there is also a text-based 
indication as well. 

● For example to highlight key cells in a table, by all means use shading or colour but 
crucially also use an asterisk or similar. 

 

Avoid relative instructions (Word and PowerPoint). 

● Some users will not be able to detect which is ‘the box on the right’ or ‘at the bottom 
of the page’ so use another means as well (the simplest is to give each ‘box’ or other 
such item its own title or caption and refer to that). 

 

Choose accessible default fonts (Word and PowerPoint). 

● While there is research suggesting sans-serif fonts (Arial, Calibri, Verdana etc) are 
more accessible on paper (so bear this in mind for documents that are intended for 
users to print out), there is no such evidence for on-screen reading. However cursive 
fonts (handwriting-style) and prolonged use of italics are proven to be harder to read 
for many people and should be avoided. 

● Minimum font size of 12 point in text documents (RNIB recommends 14 point 
minimum). 

 

Avoid footnotes (Word and PowerPoint). 

● They are exceptionally problematic for many accessibility reasons so please just 
avoid them. 

 

Avoid obliques (except in maths notation etc) (Word and PowerPoint). 

● Things like ‘and/or’ or ‘she/her’ – try to find any other way to say it without the 
oblique, such as ‘she or her’. 
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Provide alt text for images, graphics etc (Word and PowerPoint). 

● Alt text is alternative text for users who cannot see the image. Right-clicking an 
image in a Word or PowerPoint will bring up an option to add alt text. In newer 
versions of these apps there is a box you can tick if the image is purely decorative 
and needs no alt text. If you do not have this box available, type the word 
‘Decorative’ as the alt text instead. 

● Ensure that if the image needs alt text that it contains any details necessary for the 
context of use but not every possible detail. Do not repeat what is provided 
elsewhere in the body text or caption other than to connect the various pieces of 
information. 

● Alt text for the same image or diagram can be completely different in differing 
contexts of use. It should be added to all images (unless purely decorative) in Word 
documents and PowerPoints. 

 

Set up tables carefully. 

● Orient ‘tall and thin’ rather than ‘short and wide’. (For example a table that is 4 x 20 
should have 4 columns and 20 rows, not 4 rows and 20 columns). 

● Avoid merged cells.  
● See also point on ‘Don’t convey information by only visual means’. 

 

Avoid added textboxes (Word and PowerPoint and similar). 

● These are not picked up by screen readers and you cannot easily give them alt text, 
so they are problematic. 

● If you need to add a textbox to a PowerPoint slide, add it to the Slide Master 
template, not just one slide. Anything that is on the Slide Master will be picked up by 
a screen reader, unless left blank.  

● The Notes field is also screen reader accessible. You can add useful information such 
as diagram explanations there if it seems too detailed to be considered alt text. If 
you absolutely have to add a text box to a single slide, you should copy and paste the 
text into the Notes field. 

 

Check colour contrast. 

● Free colour contrast checkers are available, such as https://www.tpgi.com/color-
contrast-checker/  

https://www.tpgi.com/color-contrast-checker/
https://www.tpgi.com/color-contrast-checker/
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● For body text aim for a contrast ratio between text and background of more than 7 
to 1. 

● For headings and isolated words or phrases, you may have a ratio as low as 4.5 to 1 
but not lower. 

● Never put text over a background image. It is very difficult to read. 

 

Think about slides being viewed on screen or in a lecture room (PowerPoint 
and similar). 

● For on-screen viewing, slide text should be a minimum of 22 point font with a 
minimum of 28 point for headings. 18 point is acceptable for less important 
information such as photo credits or references. 

● Try to have a maximum of 5 bullet points or sentences per slide. 
● Avoid animations that make the slide appear to spin or ‘enter’ from the side. 

Animations that reveal part of the text gradually are ok. 
● For presenting in a lecture room, slides should have light-coloured text on a dark 

background if the room will be dark, and dark-coloured text on a light background if 
the room will be light. If the usage context is unknown, choose either of these as 
long as the combination is not black and white (navy and cream is a popular 
accessible combination). 

 

Accessibility principles for PDFs 

 

Note that if the above principles for Word documents are all applied prior to the PDF being 
generated, the PDF will ‘inherit’ all of the accessibility features present in the Word 
document.  

However you should also additionally follow these three checks: 

 

Check end-user accessibility permissions are available. 

● This should happen by default, unless your organisation has prevented it for some 
reason.  

● Check by opening the PDF in the free version of Adobe Acrobat Reader 
(http://get.adobe.com) as this is what the majority of your users will be using (if you 
have a more advanced Adobe package, you should test on a different device which 
does not have that package installed). Go to Menu, select Preferences (near the 
bottom of the list) and choose Accessibility in the left menu. You should be able to 

http://get.adobe.com/
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check the Replace Document Colours box at the top, and then select the Use High-
Contrast Colours option. If you can successfully do this, your document should 
change to high-contrast colours – don't forget to restore it to normal before closing 
or every PDF you open in future will also have High-Contrast colours! 

● If the Replace Document Colours option is not available, it is an indication that your 
organisation has locked down the accessibility features of PDFs you produce. It is 
suggested that your organisation changes this approach, and you should share only 
Word-type documents and not PDFs.  

 

Check alt text has moved through correctly from the Word document to the 
PDF. 

● If you have the paid-for Adobe Acrobat Pro, you can check alt text in a PDF by 
turning on the Tags pane (View > ShowHide > Navigation Panels > Tags). You can 
then right-click each image in turn and select Properties > Object Properties > Tag > 
Alternative text. 

● If you have only the free Adobe Acrobat Reader, which is what the majority of your 
users will use to access the PDF, the only way to check alt text is to use a screen 
reader.  

● You can download a free screen reader called NVDA from 
https://www.nvaccess.org/download/  

● When NVDA is running, you can use the ‘down arrow’ key to move between sections 
of the PDF. If alt text is present, it should be read out when the reading order arrives 
at the image (note this may not be the same as where it appears visually in the text – 
see the next section on ‘Check the reading order of the entire document’). 

 

Check the reading order of the entire document. 

● If you have the paid-for Adobe Acrobat Pro you can check the Reading Order by 
selecting Tools > Accessibility > Reading Order to pop up a panel titled Reading 
Order. Numbers should appear on the page indicating the reading order. If 
something is out of place, go to the Reading Order panel and select the button for 
Show Order Panel. In the panel that appears (on the left side) you can simply drag-
and-drop the items to change the order.  

● If you do not have Adobe Acrobat Pro, first you should open the PDF using the free 
Adobe Acrobat Reader. Select Menu, then Preferences, the Reading from the left 
hand menu. Check that next to Reading Order, the dropdown list is showing ‘Infer 
Reading Order From Document’. This ensures that the true Reading Order the 
document has inbuilt will be shown to you. 

● Then you have two options. Using NVDA and the ‘down arrow’ key you can check the 
reading order. This is a time-consuming method and would only be recommended 
for a document of 1 or 2 pages.  

https://www.nvaccess.org/download/
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● The other option is to install the free tool PDF-Xchange Editor. With this tool if you 
go to the Accessibility Tab > Reading Order you should see the Reading Order via 
numbers on the page. If you need to change anything, click the Order button in the 
left hand menu, which opens up a nested list of items. You can move items around 
the list by using drag-and-drop (note that this does not affect their visual placement 
on the page). 

 

Accessibility principles for Easy Read documents 

This guidance covers only the document formatting aspects of Easy Read documents. There 
are also many areas to consider in terms of the actual text and images used – that's a whole 
workshop in itself!  

● Easy Read documents are normally formatted to make printing easy, so ideally A4 
size, or A5 if necessary. 

● An Easy Read document should not have more than around 12 pages. If your 
document has more than this, consider making two documents. 

● Follow the general principles for Word documents, except: 
o Use a minimum 14 point sans-serif font and larger for headings. 
o Use a minimum 1.5 line spacing. 
o Avoid abbreviations such as e.g. or etc. 
o If a sentence goes beyond one line, cut it where people would take a breath. 
o Always left-align text. 
o Use a lot of white space with wide margins. 

● Use images to illustrate key points but make sure they are on the same level as the 
text, not above or below. 

Further guidance can be found here https://www.inclusion-europe.eu/easy-to-read-
standards-guidelines/  

 

Accessibility principles for online courses 

 

Generally speaking, online course materials should follow the same principles as for Word 
and PowerPoint documents. Other considerations include: 

● Platforms such as OpenLearn Create offer users the opportunity to change certain 
settings to meet their needs, but fundamental accessibility measures (such as alt 
text) still need to be provided. 

● If a user needs to take an action that is not obvious, provide straightforward 
guidance before they arrive at the action. For example, “You will finish this course by 

https://www.inclusion-europe.eu/easy-to-read-standards-guidelines/
https://www.inclusion-europe.eu/easy-to-read-standards-guidelines/
https://www.open.edu/openlearncreate/
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pressing the ‘Next’ button. This will take you to a ‘Course complete’ window – you 
should close this window and return to the window that displays the list of courses.” 

● Navigation – this is a particular concern for online courses. If login is required, this 
should be as obvious and simple to achieve as possible. A logged-in user should be 
greeted by name to make it obvious that they are currently logged in. 

● Navigation should also be consistent, with each new section behaving in the same 
way as the previous one. 

● If new windows need to be opened, the user should be warned about this and 
should be given guidance as to what to do next. This is of vital importance for screen 
reader users, who may be completely lost by a new window opening without 
warning. All links to external URLs should open in a new tab or window and a 
warning about this should be included in each link label. 

● Be very consistent with directions. Decide which terms to use (for example ‘forward’ 
and ‘back’ or ‘next’ and ‘previous’) and use them consistently in all relevant places. A 
single item within a course should be consistently referred to (for example as a 
‘page’ or a ‘section’ or a ‘step’ etc). Ensure that this consistency of terminology 
extends to alt text and button/link labels. 

● Every page should have a link to the main menu or support. 
● The main menu or homepage for the courses should have a link to an ‘Accessibility’ 

page, which should give a brief statement of your organisation’s approach to 
accessibility, as well as guidance to users in terms of making their browser settings 
more accessible for them (e.g. magnification, darkmode etc) before they open the 
course materials. Obviously only mention what will also be applied to the course 
materials – if a darkmode or zoom setting will not also put the learning materials 
into darkmode or zoom then don’t include it in the user guidance. 

● Avoid horizontal scrolling, even on mobile devices. 
● Users should be told clearly and simply what they need to do to obtain any badges or 

other records of their study of the course. If they need to complete a certain number 
of pages or a quiz in order to be eligible, this should be stated on the main menu and 
also upon login to every individual course. If achievements can be accessed via their 
login profile, this should be clearly stated on the home or menu page. 

● Any downloadable certificates or badges should be accessible with appropriate 
filenames (for example “EVERY1 Course 3 Certificate.pdf”). 

 

Accessibility principles for webinars, video recordings, and other 
synchronous events 

● Record the session if possible and inform attendees when the recording process 
begins. Offer a short unrecorded period at the end for additional questions. 

● There are conflicting arguments about whether to keep your webcam on when 
presenting. Certainly, it is good to put it on initially for the audience to recognise 
you. After this it can be an aid to some (particularly deaf users) and a hindrance to 
others (those with distractibility issues and those with low bandwidth). 

● Slides should be prepared according to the ‘Word and PowerPoint accessibility 
principles. 
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● If audience members are invited to contribute by speaking, they should wait until 
you invite them to speak, and you, or they, should say who they are, for the benefit 
of those who cannot see the screen. 

● If using breakout rooms, the process for moving people into the rooms should be 
explained clearly before it happens, and each room should contain a slide with 
details of the discussion task. 

● The session should keep to time. Users who are paying for an assistant (such as a 
sign language interpreter) will have paid for a specific amount of time. 

● If the duration of a session is longer than 60 minutes, schedule at least one 5-minute 
break. If the session is 120 minutes or longer, schedule at least 5-minutes of break-
time per hour. If the session is 180 minutes or longer, a break of at least 20 minutes 
should be scheduled, as well as shorter breaks each hour. 

● Subtitles should be added to any videos used as recordings after the event. Live 
automated subtitles are also now available in Microsoft Teams and Adobe Connect, 
so these should be switched on if available. 

● Any visual material (such as video) needs a transcript alongside. This may be simply a 
copy of the subtitles generated, but there are two requirements: 

o Firstly, the automated subtitling is not 100% accurate, especially with names. 
It MUST be checked and corrected where necessary. 

o Secondly, anything that happens visually that is not also featured in the audio 
(and therefore also in the subtitles) needs to be described in text form and 
inserted into the subtitle-based transcript. This includes explanations of any 
‘action’ on the screen (if it carries important meaning) and also any diagrams 
or graphs that are shown if the speaker does not clearly explain them in the 
audio and subtitles. 

 

Accessibility principles for games 

● Online games should follow general accessibility principles for web sites, i.e. the 
latest version of the Web Content Accessibility Guidelines (currently version 2.2 can 
be found here – version 3 is in development and should be more straightforward to 
follow). Aside from the usual guidance about text size, colour contrast etc, one key 
point to note is that everything should be accessible via the keyboard i.e. not 
requiring the use of a mouse. In addition it should be possible to pause games and 
store progress for later. 

● Offline (physical) games. The same general principles apply as to offline materials 
(see above). 

o Colour: avoid issues regarding red/green colour blindness; check colour 
contrast is adequate.  

o Text: avoid written text as far as possible to allow play in any language. When 
text is essential keep its legibility in mind – use a sans-serif font in a large font 
size (minimum 14 point at A4 print size for key information like instructions, 
12 point is acceptable for supplementary information such as licensing rules). 

o Images: use clear illustrations / iconography: easy-to-understand icons and 
symbols that do not rely on colour differentiation alone. 

https://www.w3.org/TR/WCAG22/
https://www.w3.org/TR/WCAG22/
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o Language: write instructions in plain language, with clear and concise rules. 
o Ability: try to ensure that the game allows players with different processing 

speeds to participate comfortably. 
o Inclusion: Keep games as gender-neutral as possible and avoid (stereotypical) 

gender roles distribution. 
o User interface: keep it simple and clear.  

 

Accessibility and AI-generated content 
 
Manual verification: Any accessibility features generated by AI (such as Alt Text, image 
descriptions, or text simplifications for Easy Read) must be manually reviewed by a human 
to ensure accuracy and context. 
 
Bias and hallucinations: AI can sometimes "hallucinate" details in images or misinterpret 
technical energy terms. Manual checks are required to ensure the "Digital Energy 
Transition" concepts remain technically sound. 
 
Prompt engineering for accessibility: When using AI to help draft materials, creators should 
use specific prompts that prioritize plain language and structured heading levels to ensure 
the output is accessible from the start. 
 

Accessibility and supporting reuse and remixing of Every1 learning 
materials  

 

Every1 learning materials are licensed CC BY-SA 4.0. To support reuse, remix and localisation 
of learning materials, each learning material will:  

 

● Include all copyright information, including attribution in the good practice title, 
author, source, license (TASL) format, with appropriate hyperlinks. 
For example:  

Clean Energy for Households was created by the Every1 project and is licensed CC BY-SA 4.0, unless 
otherwise stated.  

● Be provided in accessible and remixable formats, for example, in addition to a PDF 
version of a resource, an easy-to-edit version (e.g. in Word and/or RTF) will also be 
provided, wherever possible. 

https://creativecommons.org/licenses/by-sa/4.0/deed.en
https://www.open.edu/openlearncreate/course/view.php?id=12164
https://every1.energy/
https://creativecommons.org/licenses/by-sa/4.0/deed.en
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Further resources 

Adobe downloads https://www.adobe.com/uk/ 

Coolidge, A., Doner, S., Robertson, T. & Gray, J. (2015, 2018) Accessibility Toolkit – 2nd 
Edition. BCcampus. https://opentextbc.ca/accessibilitytoolkit/  

Heggart, K. & Fatayer, M. (eds.) (2024) Designing Learning Experiences for Inclusivity and 
Diversity: Advice for Learning Designers. UTS. https://oercollective.caul.edu.au/designing-
learning-experiences/  

Inclusion Europe (n.d.) Information for all: European standards for making information easy 
to read and understand. https://www.inclusion-europe.eu/easy-to-read-standards-
guidelines/ 

NVDA Screen Reader https://www.nvaccess.org/download/  

Vispero (2026) Colour Contrast Analyser (CCA) https://vispero.com/lp/color-contrast-
checker/ 

Web Content Accessibility Guidelines (WCAG) 2.2 (2024): https://www.w3.org/TR/WCAG22/ 

 

https://www.adobe.com/uk/
https://opentextbc.ca/accessibilitytoolkit/
https://oercollective.caul.edu.au/designing-learning-experiences/
https://oercollective.caul.edu.au/designing-learning-experiences/
https://www.inclusion-europe.eu/easy-to-read-standards-guidelines/
https://www.inclusion-europe.eu/easy-to-read-standards-guidelines/
https://www.nvaccess.org/download/
https://vispero.com/lp/color-contrast-checker/
https://vispero.com/lp/color-contrast-checker/
https://www.w3.org/TR/WCAG22/

